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—. BEEHE

Cadence /&N RB[H EDA %A, & JLFnl ASe b 73t it s
JiTfITH , W ASIC Bevl . FPGA Wi Al PCB s vt &%, 7RI, g
Bty HANAGRAT S W vt B 1R 4 g Th A8 AT 2 TR AR 3

NTHFATH AN ZE 5 IO I B AR A 41 /41 Cadence ff—
BERLARHRAE o

TEIEHf224% cadence J5, BRE LAERY, P40, fE2%5 DA

T4 icfb&, 2B Cadence HJURFTHI, JF4HTJT candence [HfiT&

1THE 11 (Command Interpreter Window , CIW) W& 1.1 fi7~o

LA NTARE

File Tools Options '

"hand schenatic" saved. ] Ry | T
"hand schematic" saved.
"band schenatic" saved.

| =

[

mouse L: M:

»

Kl 1.1 ciw & M

FENIA N AR AT P AR 57k

(1) File - New - Library
(2) Tools = Library Maneger ] JT £ & #ll 2%

BEAL, AR 7 vk R 2 AN N TAEE . 4T JF Library Maneger
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WA 1.2 fros:

Library Manager: WorkArea: [home/fanmmj/proj/nt25190

File Edit WView Design Manager Help

| I Show Categories| 1 Show Files

— Library cell View

25159

2151wy
2E1507%gl
251591 %g2

E M hvuangy rwl
G_zhangr_rwl
I_wangjlk_rwl
L_H wercos rwl
analogLib
bakeup projectl
basic
cdsDefTechlLib
fsimulation
k_chenghs_rwl
tsmcl3ct

zhusy 251901

— Messages

but was defined in likFile * /home/farmmSproj mt251907cds. 1ib* for Likh ‘E =
Log file is “/home/fanmm/proj /nt25190/1ibManager. log. 1",

"

[# 1. 2. Library Manager %I

WP RN T YW EAE. AidiFile 2 New =

Library §]JF New Library % L& 1. 3 fizs:

)
— Library
-
Directory

Shone /Earom fpro] 251904,

— Design M

) ise HOHNE

) b Mo BA

OK | Apply | Ccancel| Help
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& 1. 3New Library % H

7€ Name £ AN H W TAEESFR, Wmylib. 2R)5 i OK,

0K | Cancel Help

Technology Fle for library "mylib"

If you will be creating mask layout or
other physical data in this library, you
will need a technology file. IT you plan
to use only schematic or HDL data, a
technology file is not required.

You can: 4 Compile a new techfile
Attach to an existing techfile
Don’t need a techfile

K 1.4

{EE AR U], 47 R B AR B B MR new
techfile CGErIHIARICM), HWHLIE Don’ t need a techfile. fE
I, FRATTIERELETN Don” t need a techfile g OK, Kids OK #fiA 5
WU SE B T ST T AR R

2. W H L (Cellview)

FIRGSCHAZREL, TAERIG (Cellview) [R5 th A Wikl 5 ik
(1) fEfA 475 i File > New 2 CellView

(2) RS PR AR B 2

FEMIRATR IS —Fh 732, HI Create New File I 1.6

FR:
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Create New File

Ok Cancel  Defaults Help
Library Hame ITyyiity
cell Name dif
View Name schematic
Tool Composer- Schematic

Library path file
home ffanmm fpro] 25190 /cds . Lik

K16
fF Library Name &£ H O TAEZE, 7E Cell Name £2%AJR

HEMAR, Wdiff. £F Tool F2i%+E Composer—Schematic Jig fiili

OK, I o 5 PR G 00 1) SR i, B LA 58 B

. YRR

NP 2. 1 Pros st FL s g 45 S

i Virtuoso® Schematic Editing; mylib diff schematic /
d: Sel:0 51

<

@ Qo

Design Window Edit Add Check Sheet Options Help

q
%

0l
o

AN EAF=

» »

L Euu.

M: schHiltousePopUp () R: delew ()

DM § |\E

mouse L: schSingleSelectPt()
m/CD[] Virtuoso® Schematic Editing

K21
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LN nas

7t Cadence ", WNHNgSIFEA —Frigts:
(1) st Add > Instance;

5 B

(2) A THESF M Insrancel % g
(3) fFHIPLgEgE i,
DL In—A NOMS A4, E R dsina 25 < I Add Instance

g 2.2 fioR:
Add Instance oo
HideJ Cancel Defaults Help

Library Browse

cel

View symbol] yr

Hames r | S0l
Array Rows [L | Columns |_l [—
Rotate | Sideways J Upside Down

K 2.2

7E Library £ si Browse 3 H FEN W 23 an &l 2. 3 Frogs:
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_| Show Cateqories

Library Browser - Add Instance ===

— Library Cell View
fanaloglih J T s |35:"m.b al
E_M huangy |- | nhsim = (Il 2ms
G_zhangr nbsimd aubdl
I wangjk_x njfet aulvs
L _H werset e S cdsSpice
analogLib e sd hspiceD
bakeup prc nmos hspices
basic oS spectre
cdsDefTeck nodefuant: spectres
fsimulatic noise symbol
k_chenghs_ rpan

]
| R | J—

Close |

Filters...

Help

Kl 2.3

L PED Va2 TP AR YK St analoglib = nmos4 = symbol Ji fiili

close., I Add Instance & <K 2.4 s

>

Add Instance

Hide ‘ Cancel |Defaults|

)

Help

Library I analoglib

| Browse |

cell |ﬂm034§_
View | symbol
Hames l

Array

Rows L

Columns | L

Rotate

Sideways

Upside Down

Model name
Multiplier
Width
Length

Drain diffusion area

ke

=T T T T T

K 2.4

it Hide BRUBCH AT S 1 o HLES SR At 0 b2 I —> v DLRE B
FrAZ AN noms, BLES 4% FPRGESRE v v DL Bh2sth, 4% R A] LUK 28
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PR AEAEH )y s AR 2B A B o 3 ZEASINE 2 noms
AIAREE LT, AN noms #34F, WH% T Esc B M a4

WA BCE AT N UR 83 0F B A FR S IR, 98 KBS
SSR VNG

FE IR RER) 73 v LS In B HL M #4440 poms,  vdd, gnd 25404

=

5

2.5 FN:

2 ]

0l
[X]

K| E S

flt -

Py

L

[0 6 B

K 2.5

VE: 1. vdd 55 gnd (24 )m IR S bR U, AT AL PR Es AT

vdd JFEANRESE AL . 7 LI L2004 gnd, 75 T AN

2. 4 T LUG BT (R, oAb v] B KL T2 B rh i F 2 1
2. SRR (] A CE S e 8O

BE TS HH =M

(1) AL S Edit > Properties = Objects 2R JFiEFf
TGS TeE

(2) WP E KSR, SE T AR o Rk

8
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(3) BEPEBESS MR, AU o

TEME, ATk & BL—> noms #4491 -

e —> noms g, HRESHBI—EHE, 25 miditRaE s
q, MHSHEE WA 2.6 Pron:

Edit Object Properties

OU Cancel  Apply Defaults Previous E ;Help
APE’ To only current instance _||
|3huw system M user l CDF
i Browse Reset Instance Labels Display

Property value Display l |
| Library Name e

Cell Hame nmosd o

View Name symhol; ~ ot

Instance Name Im: ~ off J

~ Add Delete Modify |

CDF Parameter Value Display
Model name ’7 _off J
Multiplier e orf
Vdth e | oft |
Length . off |
Drain diffusion area off
Source diffusion area b _off _J
Drain diffusion periphery '- N | off
Source diffusion periphery ', k| off .
Drain diffusion res squares ’— off
Source diffusion res squares [ T off :J
Drain diffusion length } e B | off .
MousePopUp () R: schHiObjectProperty() —

2.6

W, FATFHEHN noms [X) model name FIFIHK 5498, X
HIRATE B 0. Tu, MEE R 4u, B S AL T R 5
pPar ( “wn” ) B HEAER A= i N A BE wn F IS S M o 15 BN AR

B owne SERSEIIB LA,

e RPRUE(EL, MOS #3F 220 N AT A FR . ARUCRFE R U A R KL T
MILE, ININTREEALN:

Library Manager——Edit—Library path 5 H 3 Library path Editor
1o fAidi%d ¥ Edit—Add Library 3 Add Library % 40 F B s
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[ | Add Library X

— Library
Name |

L bse danpad Hame

Directory Library

{ Go up a directory } A

R i
@2y B %A 1 J
huanggang
lost+found
usrl
usr
usr3
A

usrd
usrs
usrh
usc
usrd i

=] T =1 T

/home

— Design b
) e BGHE
) Line Ma DA

0K Apply Cancel Help

T EFE#EN

|3mic18mmrﬂ

Ausc/LibraryfsmiclBmmef 1PEM 200902271408 /smiclBmmr

M4 L2 PR AR AT N, IS IN5E A st OK £E Library path Editor %
F A ) File &I il Save As 3T, 520NN
%@BDEEJZFTT ’f. Library Manager & A A T 27, W NEIFR:

Library Manager: WorkArea: /home/wangwy

Fle Edit View Design Manager Help
.| Show Categyories | Showr Files
— Library Cell View
fanic 18mmef Trowwt 33 H
Us_8ths nlf A ultrasin
ahdlLib nl8_ckt rf ads
analogLik n33 ams
hasic n33_ckt_rf anGdl
cdsDefTechLih ndiolf aulws
functional ndio33 J hspiceD
cfExamples k1 ivpcell
cfLib k33 layout,
smicl8nmef rndiold spectre
rndiod3 symbol
ntl8
nnt33
npnlf
npnl8 W2L2
npnl8 WELE
npn1f_W10L10
npn33
npn33_WILZ vl
T
Log file is " /homefwangwy/libManager. lag" ’j
A 1]

] DU I H e gm 4 eds. 1ib SN T2 )%,
SR InsE R E K 2. 7 Fios:
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Sel: 1 51

Cm

Tools Design Window Edit Add Check Sheet Options Help

m mouse L: schSingleSelectPL() M: schHiMousePoplUp () ER: schHiSawveCellWiew()

2D¢|[ ] Virtuoso® Schematic Editing

K 2.7
B WESHENAZE A RL (KERNEK), REGSHBIN
J::O

3.2 1%L

IS IS AT IESAT =M 5k

(1) miikHEEAdd > wire (narrow);

il
(2) midh THAESW B b
(3) i PRyEs w (- FEER) BV (REIERD;
PRI L A2 Ja nI AT IR LL, FEWCH s il Esc B HY 4
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LA, ATARBHEL . L ATHR it Esc IBHIEL Ar 2o midith
FEHE 1l DI 44, AT LR A A4 A2 sl B0 NOE LML . I 2. 8
IV

~_ Viruoso® Schematic Editing; mylib diff schematic
Cmd: Sel: 0 5

Tools Design Window Edit Add cCheck Sheet Options Help

& &

P
Y

0
[¥]

DN |

DI § S

mmmmm schiingleSelectP() M: schHiMousePopUp () F: schHiSaveCellVWiew()

2.8
4. J3UCE i 1

o P PR T AR 8 T A I, B 5 SO 1/0 33 b W e e
N . OB T R T

(1) ZEHFHd Add 2 Pin;

(2) i THEEE T

(3) fi i B ps

45 HBCE A & SR 2 I Add Pin B A1 2. 9 T
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Add Pin

Hide Cancel | Defaults Help
Fin Hames |Vin]I
Direction input. Bus Expansion 4 off ._ on
Usage schematic Placement # single - multiple

Attach Net Expression: 4 Mo Yes
Propmriy Mo

fatault Het Name |

Eput Helgt g Font Bl Eali
I e Al Ewardaniay Fraby Sivie  Dxed affset
Rotate Sideways Upside Down
K 2.9

FEBCE B N\ I UAE Pin Name £2%1 A Vin, 7E Direction F4i%
P& input AR5 miidi hide, W50 SR ANZ o[RBT 0%
i 1, 7 EE Direction B5UfJEi%+F output fEH A 44 . %%

S8 L B T 1A 2. 10 TR

] 2.10
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5K 5 0R A

SR > Check and Save BYE #EA P KNS X, Al LL
N HL S AT R B A K B S W RS E CIW & 1 b B e Rk,

File Tools Options

Extracting "diff schematic’
Schematic check completed with no errors.
"mylib diff schematic" sawved.

mouze L: mousedddPti) M. schHiMousePoplp () R: Rotate 90
Use the options form to supply terminal names for the pins.

K 2.11

=. fI& symbol

FT T 10 G 1) 26 53 TIOR3
Composer % 154~ = Design = Create CellView = From

Cellview, 3iH} Cellview from Cellview % 1. WK 3.1 7.

Cellview From Cellview

0K lCan[:eI Defaults | Apply Help

Library Hame nylih Browse I

Cell Name (diff

From View Hame schematlic - | To View Hame 3‘5’“1330_]5.

Tool / Data Type  Composer- Symbol

Display Cellview N

Edit Options [ |

3.1

AR CAEALS, Sl OK B, 9 HI G4 symbol % HI AN 3. 2

Bz, BAERL A 2l R0 i N A i 1]

14
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OK | Cancel Apply Hel}

Library Hame Cell Hame View Hame
T 11k diffi syahol;

Fin Specifications Attributes
Left Pins | vinl winZ ; List
Right Pins  vout | List
Top Pins List
Bottom Pins List

Load/Save Edit Attributes Edit Labels Edit Properties

K 3.2
A OK, s symbol Zmia g I anl& 3. 3 fios:

5
” G i =[a]=

Cmd: Sel: 0 52
Tools Design Window Edit Add Check Options Help

£y |mouse L: mouseSingleSelectPt M: schHiMousePopUp ()

K 3.3
e BRI ERE T BT Bias X—HIAG S G, S HIEL, nfDIER 3.2 H Left Pin il
WA Bias ¥ I, 8] DAZE K A B8 0 Bias ot 11, W ERES .

ERUAH Symbol s —ANEECKIAEE . X g, AT B —

DNk R IR g EHE & delete, #RJ5 Add = Shape =

F: schHi¥iewToView ()
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Polygon, ZENIAFETEHE I B — D =FTE. BARE =" hi s 3
URRIA] o PR g A\ H i 1 LA partname Fil instanceName 2
B EEALE . W 3. 4 FiR:

U@ﬁEﬁEHEEHﬂﬂHﬂ

K 3.4

H 1) Symbol 5 M {5 4F. Design = check and save, £

AR R AE CIV & H

PO H B E

1L EA RN A

ADE & Cadence IC HJEEALA ELIA ST, Al LAHIAN 5 (4T T
(L . ATRAAE CIW & A IEFRH Tools > Analog
Environment Simulation, IXAF4T T ADE & H Hh 45 € #EAT T H

) HL B
(2) . 7EHL g 44 T IE R Tools > Analog

Environment, IXFEFTFFH) ADE & [ v & N5 B i H ADE Y H,
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%Eom T A 4.1 Fros:

Virtuoso® Analog Design Environment (3)

Status: Ready T=27 C Simulator: spectre 59
Session Setup .q.nalyses Variables Outputs Simulation Results Tools Help
Design Analyses '-%
i iy, N [ Type Arguments e TV 4 Enable T
. . ||# Type  Argumenks.................. o
Library mylihb . L . R
4DC
Cell  dift 1 |—
| ewr SCeEmartlc ¥z
Design Variables Outputs ‘ D;E:
# Neme  Value  |# Name /Signal /Expr ¥alue Plot Sawe March

‘ Plotting mode:  Replace | I/'\/
I - ] |

K 4.1
PEAb A E T2, AL+ setup 2 model

libraries, ML E T EFME DK 4. 2 Fros:

spectre2; Model Library Setup

oK ‘ Cancel Defaults‘ Apply | Help
d L« BN BN | |
[#Disab _|Mc|del Library File [ | ~ Section n

| Erpabibe ||
. e-backup/tilimmspliikl 13a/tamclicf/. . /models/temclicf. sca [

St
I

B

| | Expueny
| |
I Model Library File Section (opt.) |
3 |
| I |
at | s Cheamss it P Bmwse...J |

4.2

FEXANE TP LLYE Model Library File £2% AR EA% (R

RIPESCAEA, A Section A= NZAE RSO/ 7 B BL
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2 ERAY LR

£ Cadence H, HRGANIFI A2, W] LGS AL #3047 AN [F) SR AL ) 20
Hro WHIEA DC 70 AC oy WEdSotr. W, Ao
s

BCEA EIRAUIN, W] LLSHE S Analyze > Choose B i ]
bro o AR ESRBN NENFRNSHBCE, 1 RKE G A

HARHEE, RMGEE L WE 4.3 Pros:

o

OK. | Cancel  Defaults Apply Help
Analysis # tran dc ac noise

=f Sens dcmatch sth

pz sp envip pss

pac pnoise pxf psp

qpss fpac fpnoise opxr

qpsp

Transient Analysis

Accuracy Defaults (errpreset)

conservative moderate liberal
Enahled Options...
4.3

3 EELE

H T L R A RAT AT 228 2 T s 2R AT R T e B, PIr LAAEXS
RGO TN, 2 e s b e - SeAR RAR N SR 2 4. Bl
ALK —/> MOS8 1) 5 S5 5 SCA w=W1, U WL 3 ok — AN e A ot
XL R AR AR L AR T EE, A AR T . — RBCETr

k. fESEH [ 1E$f Variables = Copy from Cell View JIJHL %P

18
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AP VAR A% R AR ERGEE ADE 1, HAE ADE B 1 AR A o
S SRR XGE A EE AR, SRR R L, 5
AL AR R AT AR I R AR . FAARERAE AT WA L5841

4,25 B3 Vi 2y

Results Browser & — B S2H I T H, nJLLAE ADE % 19

Tools BT $R A o I & ) AT AT L it 1 i A R R 1 HL A
I 45 R IF HLAT DU Bl g AT HUAL B, 7253 ) B PSR A B .
Ubah, AL T EdELLE, Y vs Y IhfE. B R THAE R

273

A, 1T Results Browser ] DLSZHL DL T IhEE:

[1] ®WENHEL

[2] BWEEASTRE,;

[3] % a8 LA R

(4] A5 &5 RACHFFIR I B b U S2os s Bl BT R 3 45 1A 5
(5] Rl A R R IE A EHEIZAF“Cal culator "HIZE A7 H

T Tools LI W] LLFT iz e W& 4. 4 Fros:
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File Settings Tools Help
= H e g Replace -
Location | | -
[rmer R B ]
[cadence
4.4

5. ZTRATE LS

XHL, FRATT DA RS B AW A B KR A @i
FLI— R o

VE: (RN ASBE EEAE ] analogLib 2, AT EAE ] 0. 13um
JEREAY o O X T THTAS IR 8 1-4E Library Name Ab& o {5 2022 4]

4.5 Pros:

20
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Edit Object Properties
0K | Cancel Apply | Defaults Previous Mext Help
Apply To only current instance
Shows system [l user Il CDF
Browse Reset Instance Labels Display

Property Value Display

Library Hame  Esmeldef off

Cell Hame pmos 3y off

view Hame symhal off

Instance Hame |14 of

Add Delete Modify

CDF Parameter Value Display
ot Manmg pch_33 off
Multiplier i off
Length 300n 1 off
Total Width fu ¥ off
Finger Width Zu i off
Fingers i off
Threshold 300n 1 off
Apply Threshold off
Gate Connection # Hone Top Bottom Both Altermate off
S/D Metal Width 1600 1 off

4.5

BEA T

kST B M AE 4 € R AN Bl 15 2 Te0E 1IN 18] v A 55
FEL PR P Sl 2 ey 2 1 E o BRIGIE VT F R AR M, R, R
G ) RS SN 28 I BRI DL IR S 23 B A BR AR HE LEAA 1R 0 T o FER S
DI S AR B R, 32 SR AE 0 FORS AN SO 2 R A 5 28
I3

BG4 vde IR HL R o IR0 ECI i A\ 25 00— ARALAH Be 1Y)
AR =TI, NG, R RGERE o BCEESIHSEL W 4.5 Pik:

21
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OK | Cancel

Apply To
Show

Browrse
Property
Library Name
Cell Hame
view Mame

Instance Hame

User Property

Ivslgnore

CDF Parameter
AC magnitude
AC phase
DC voltage
Voltage 1
Voltage 2
Delay time
Rise time
Fall time
Pulse wridth

Period

©2012

only current

Edit Object Properties

Apply | Defaults| Previous | Mext

instance

system M user l CDF

Reset Instance Labels Display

Value
analogLik
vpulse
symbol,

vz

Fuldd
Master Value

Delete

TRUE

Value

5 s
10 =

K 4.5

I I8 5 s an 1 4. 6 Fios:

22

Modify
Local Value

Display
off
off
off

off

Display
off

Display
off
off
off
off
off
off
off
off
off

off

Helf



f-1r|.:||.

A |,T

Kl 4.6
VE: BRANT B R) DL A H A Fr et i) symbol, X symbol LIRS INAE
AT, S8 Iy W 7 18

UL A B, RS AR Setup % #f model library,
s W 4.7 s

0K Cancel | Defaults | Apply Help

#D01sable |[Model Library File Section .
Savnde

.. e-hackup 01 3mmsp001kl_13a/tsmel3cfs. . /modelstsmcl3cf. scs

Danids
HEH
Erawin
Model Library File Section {opt.)
#ihi Dmiein {hmgn Bl Bia Browse...
K47

FEMLIERA B E . SR )5 Aih Analysis = choose # i {f HLAS Y

RS, RS E tran, S stop time, JEHf5%E Enable 4b

23
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Tk deR A Sy 0K, i 4. 8 fiow:

OK | Cancel | Defaults | Apply Help
Analysis 4 tran dc ac noise

wf Sens dcmatch sth

pz sp envip pss

pac pnoise p=T psp

qpss gpac gpnoise gpxf

qpsp

Transient Analysis

Stop Time | 50u

Accuracy Defaults (errpreset)
conservative moderate liheral

Enabled W Options...

Kl 4.8
SR 5T ADE % I, Output = To Be Plotted = Select On

Schematic, XFESHTHFRATm T . R 0 ) Bk A A RN HH
P S IN FIT OUT. (A iy 1 A e B/ v i1y S H ) R
135 v 22 23 W B v (K i N i, ADE % 11 outputs FELSIE A FE Y

G, WK 4.9 Pros:

24
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Session Setup Analyses Variables Outputs Simulation Results Tools Help

Design Analyses P%

il . B . Al Eimil &
# A ts. .. .. 4 8. R Enzbl
Library myLib F YO T i T
Cell diff | |1 tran 0 Elu YES _DC
. 1y
View  schematic = -Y-Z_.
Design Variables Outputs [Ej |
#  MName value #  Name/Signal/Expr Value Plot Save March _I =
| |
[ 1 wout ves allvy no | }}/
2
3

winl ves allvy no [
vind yes  allv no E

Ji
= 3elect on Schematic Outputs to Be Plotted

K 4.9

&Eﬁﬁ%ﬁﬁEﬁ%@%%ﬁﬁA%&%%%Eﬁ%om@
4. 10 Fh7s:

Flotting mode: Replace l % [

~ fvout = fvinl = fvin2

3.5

3.0
2.59
za.0d
>15]
1.04
59

[4}

3.5

c
35

3.04
2,59
Z2.04
=
1.54
1.04 e —

I3
v T T T
0 10 20 30 40 50
us

il
3.0 & — e
259
=204
=
159
1.0 S — L d—=—— 1 L

4. 10
B (DC Analysis)
B HT R AT i B SR . 7 “Tran Analysis”. “AC
Analysis” ZE AT RE T, B e b2 B EIR LR [ 4R
HLIE 1) T 0 A F S E L

25
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FEIX HLPRATT LA 2 75 v K AR AL A58 B B0 BEA T B0 AT

TR LS S, ARG S IR E N AR B, WE AR NE
AITHA . 25, PiAHEE A D>Variables—>Edit, B3 HE:
S T AR Edit Variables &4, S e 0. o fdis
“Copy From”, t4s &1t FRATHTTHIAE DR L P I AR AL & vine 1
¢ﬁ§%,ﬁm&§~A%%ﬁlng4nﬁﬁ%

e [E3]
OK | Cancel | Apply | Apply & Run Simulation Help
Selected Variahle Table of Design Varahles
T win #  Name Yalue
value (Expr) |1 1 vin

fdd | Delete | Change  Mext | Clear Find

Cellview Variahles Copy From | Copy To

K 4. 11

At oke #RJGAE ADE % 1P #EF#¢ Analysis = Choose, EFH

WA E de, MU B B WE 4. 12 Frox:

26
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Analysis tran & dc
BT SBns
pz 3p
pac pnoise
qpss gpac
qpsp
DC Analysis

Save DC Operating Point

Sweep Varahle
Temperature
Ml Design Variahle
Component Parameter
Model Parameter

Sweep Range

# Start- Stop
Center-Span

Start

Sweep Type
Automatic

Add Specific Points

Enabled W

ac noise
dematch sth
envip pss
pxf psp
gpnoise gp=f

Variable Name | vir

Select Design Variable
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